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1 Dokumentziel und Konventionen

1 Dokumentziel und Konventionen

Neben technischen Daten beschreibt dies Dokument die Produktnutzung und -funktion. Mögliche Kombina-
tion mit anderen Nanotec-Produkten erfragen Sie bitte bei Ihrem Nanotec-Vertriebspartner. Ehe Sie das Pro-
dukt nutzen, beachten Sie bitte Dokument-Schriftstile und -Konventionen.

Unterstrichener Text markiert Querverweise und Hyperlinks.

Beispiel 1: Unsere Sicherheitshinweise beachten.

Beispiel 2: Nötige Codevorlagen herunterladen von unserer Webseite für EMEA / APAC oder AMERICA.

Graufettes Kursiv benennt Menüpfade, Buttons, Tabulator- und Dateinamen.

Beispiel 1: Home > Connect controller > CANopen wählen.

Beispiel 2: Im NanoJ-Tab: NanoJ project wählen und Analog Input.cpp öffnen.

Simples Kursiv markiert Freihand-Einträge und fremdsprachige Ausdrücke. Zudem betont es Worte von kriti-
schem Gewicht. Alternativ geben geklammerte Rufzeichen(!) kritisches Gewicht.

Beispiel 1: Plug & Drive Studio eintragen. Neben dem Nutzer (= user; usuario; utente; utilisateur; utente
etc.). adressiert dies Dokument auch:

- Drittnutzer (= third-party user; tercero usuario; terceiro utente; tiers utilisateur; terzo utente etc.).

- Endnutzer (= end user; usuario final; utente final; utilisateur final; utente finale etc.).

Beispiel 2: Schützen Sie sich, andere und Ihr Equipment. Befolgen Sie unsere allgemeinen Sicherheits-
hinweise generell für alle Nanotec-Produkte. Befolgen Sie auch die spezifischen Sicherheitshinweise ei-
gens für dies Produkt.

Courier markiert Codeblöcke oder Programmierbefehle.

Beispiel 1: Per Bash: sudo make install öffnen; geteilte Objekte kopieren; dann ldconfig öffnen.

Beispiel 2: Per folgender NanoLibAccessor-Funktion das Logging Level in NanoLib ändern:

//
        ***** C++ variant *****
 void setLoggingLevel(LogLevel level);

Das Verb co-klicken

Co-klicken heißt: Klick per Sekundär-Maustaste, um Kontextmenüs etc. zu öffnen.

Beispiel 1: Datei co-klicken, Umbenennen wählen und Datei umbenennen.

Beispiel 2: Datei zum Prüfen co-klicken und Eigenschaften wählen.

Zahlenwerte

Zahlen erscheinen dezimal. Hexadezimal-Notation endet auf tiefgestelltem h. Objekte im Objektverzeichnis no-
tieren hexadezimal als <Index>:<Subindex>, nicht-notierte Subindizes als 00h. Beispiel: 1003h:05h ist
Subindex 5 im Objekt 1003h. Und 6040h ist Subindex 00 im Objekt 6040h.

Bits

Jedes Objektbit zählt hoch ab LSB (Bitnummer 0),
wie etwa Datentyp UNSIGNED8:
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1 Dokumentziel und Konventionen

Zählrichtung (Pfeile)

Abbildungen zählen stets pfeilwärts; beide Beispiel-
objekte 60C5h und 60C6h sind also positiv.

Max. acceleration (60C5h)

Max. deceleration (60C6h)
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Versionen

Dokument-Version Datum Änderungen Produkt-Release

1.0.0 12/2021 Veröffentlichung 1.2.0
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2 Zu Ihrer Sicherheit

2 Zu Ihrer Sicherheit

Stellen Sie für bestimmungsgemäße Produktnutzung bitte sicher, dass alle Nutzer und Endnutzer dieses Do-
kument vollständig lesen, verstehen und befolgen.

2.1 Warn- und Risikostufen

Bitte beachten Sie, dass Warnhinweise, Alarmsymbole und Signalworte in diesem Dokument verschiedene
Risikostufen markieren.

WARNUNG

! WARNUNG warnt vor möglicher Lebensgefahr!

Schwerverletzte / Tod möglich.

► Anleitung gegen lebensgefährliche Bedienfehler.

VORSICHT

! VORSICHT warnt vor möglicher körperlicher Gefahr!

Leicht / mittelschwer Verletzte möglich.

► Anleitung gegen ungesunde Bedienfehler.

HINWEIS

Ein HINWEIS warnt vor Fehlbedienung.

Sach- oder Umweltschaden möglich (nicht unbedingt Verletzung).

► Anleitung gegen destruktive Bedienfehler (= rein materielle Risiken).

Anm.: Erklärt oder vereinfacht per Zusatzangaben einen Vorgang.

2.2 Allgemeine Sicherheitshinweise

Schützen Sie sich, andere und Ihr Equipment. Befolgen Sie unsere allgemeinen Warnhinweise generell für
alle Nanotec-Produkte.

WARNUNG

!
Schwerverletzte, Tod, Maschinenfehler: durch Fehlnutzung!

► Produkt nur als qualifizierte Fachkraft handhaben.

► Zur nötigen Sicherheit: Gültige OEM-Anleitungen befolgen.

► Produktkennzeichnung und Anleitung abgleichen.

► Korrekte Anleitung fürs korrekte Produkt stets lesen.

2.3 Spezifische Sicherheitshinweise

Befolgen Sie für korrekten Schutz unsere spezifischen Sicherheitshinweise eigens für dies Produkt.

Version: 1.0.0 5



2 Zu Ihrer Sicherheit

WARNUNG

!
Schwerverletzte, Tod: durch Produktmissbrauch für Sicherheitszwecke!

► Produkt nie als Sicherheitsmodul integrieren / nutzen.

► Falls Sie das Produkt installieren: Kunden eigens von Missbrauch abhalten.

► Unsere Sicherheitshinweise / Anweisungen sofort mit Ihren Kunden teilen.

2.4 Zusätzliche Sicherheitshinweise

Befolgen Sie im Umgang mit Fremdprodukten unsere zusätzlichen Warnhinweise und gültige OEM-Anlei-
tungen.

WARNUNG

!
Schwerverletzte, Tod: durch unpassende Drittausrüstung!

► System- und Hardwarevorgaben erfüllen.

► Nur kompatible Ausrüstung nutzen.

► Gültige OEM-Anleitungen befolgen.

Version: 1.0.0 6



3 Bevor Sie starten

3 Bevor Sie starten

Vor Produktnutzung sind der PC vorzubereiten und Produktzweck / -limits zu ermitteln. Per Online-Hilfe ler-
nen Sie Projekte installieren, einrichten und wie PNDS3 läuft. Sicherheitshinweise im Handbuch befolgen
(www.nanotec.de).

3.1 System- und Gerätvorgaben

WARNING

! Schwerverletzte, Tod: durch echtzeitunfähige Umgebung (Windows-PC etc.)!

► Produkt von zeitkritischen Anwendungen oder synchroner Mehrachsbewegung fernhalten.

► Nie als Sicherheitsmodul in Produkte / Systeme integrieren.

Plug & Drive Studio 3 (PNDS3) braucht 64-Bit-Betriebssysteme. Nanotec empfiehlt Controller-Firmware FIR-
v2139 oder neuer. PNDS3 bietet eine Spezialsteuerung für firmware update.

PNDS3 64-bit OS-Vorgaben Feldbusadapter / -kabel

v1.3.0 ■ Windows 10
■ .NET Framework 4.8
■ Bildschirmauflösung 1920x1080

■ CANopen:

□ IXXAT USB-to-CAN V2
□ Nanotec ZK-USB-CAN-1

■ Modbus RTU:

□ Nanotec ZK-USB-RS485-1 oder
äquivalenter USB-RS485 Adapter

□ USB-Kabel via virtual comport
(VCP)

■ Ethernet (REST) , EtherCAT,
Profinet:

□ passendes Ethernet-Kabel
□ WinPcap 4.1.3- oder Npcap-

Installation, siehe Installation und
Adapter

3.2 Produktzweck und Zielgruppe

HINWEIS

Schäden: durch ungeschultes Personal!

► Produkt nur für den Zweck nutzen, den dieses Dokument beschreibt.

► Nutzung nur auf Fachpersonal begrenzen.

► Gültige OEM- und Systemvorgaben für beteiligte Ausrüstungen befolgen.

Plug & Drive Studio 3 (PNDS3) ist eine Gratis-Software für simple Inbetriebnahme von Nanotec-Antrieben.
Unterlegtes Betriebssystem / Hardware (PC) ist nicht echtzeitfähig. PNDS3 nie synchron mehrachsbewegt
oder zeitkritisch nutzen; nie als Sicherheitsbauteil in Produkte / Systeme integrieren.

Ergänzen Sie jedes Endnutzerprodukt mit Nanotec-gefertigtem Bauteil um korrekte Warnhinweise und An-
leitungen für sicheren Gebrauch / Betrieb. Übermitteln Sie Endnutzern jede Nanotec-Warnung direkt. Das
Produkt adressiert allein Experten in Industrie-Anwendungsfällen. Experte heißt:
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3 Bevor Sie starten

■ Ausbildung / Erfahrung im Umgang mit Motoren plus Steuerung
■ Verstehen dieses Dokuments plus Nanotec-Antriebshandbücher

■ Kenntnis gültiger Vorschriften

3.3 Lieferumfang und Garantie

PNDS3 kommt als *.zip-Ordner von unserer Download-Website für je EMEA / APAC oder AMERICA. Spei-
chern und entpacken Sie den Download vor Installation korrekt. Das Produktpaket enthält:

■ Software als ausführbare Datei
■ Projektvorlagen

■ Aktuelle Firmware-Version
■ Online-Hilfedatei

Zum Garantieumfang beachten Sie bitte unsere Geschäftsbedingungen für je EMEA / APAC oder AMERICA.
Anm.: Nanotec haftet nicht für falsche Qualität, Handhabung, Installation, Betrieb, Nutzung und Wartung von
Drittgeräten! Gültige OEM-Anleitungen befolgen.

Version: 1.0.0 8
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4 Ihr Produkt

4 Ihr Produkt

Mit PNDS3 parametrieren und nehmen Sie Nanotec-Antriebe in Betrieb. Per Templates für diverse Nanotec-
Antriebe ergänzen Sie den modularen Bedienschirm um eigene Projekte, Systeme, Module. Die Software
enthält eine Standardordnerstruktur (Project, System, ModulesGroup, Module etc.).

Projekt (Basisordner Projects)

Sie pflegen alle Settings und Geräteparameter in Projekten, speichern diese als
Datei und im- / exportieren sie, etwa als Templates. Solch neu nutzbares Project
kann mehrere Systeme haben, etwa die Achsen einer Maschine.

System (Basisordner Systems)

Im Projekt (hier: externer Controller) erstellen und speichern Sie Antriebssys-
teme (hier: X-Achse). Jedes ist im- / exportierbar als Vorlage.

Solch neu nutzbares System, aus zumindest Motor und Controller, ist erweiter-
bar um Module oder Modulgruppen für Encoder, Getriebe, Bremse, Settings,
Parameter etc.

Per Parameter, sortier- / poolbar in mehrere Module oder Modulgruppen, steuern
Sie schnell alle Systemelemente.

Modul (Basisordner Modules / Module Groups)

Ein Modul enthält Parameter, Bediengruppen oder -regler und ist, einzeln oder
gruppiert, im- / exportierbar als Template.

Bediengruppe (Basisordner Groups)

Eine Controls group bündelt einzelne Geräteparameter (Objekte vom
Verzeichnis im Controller) und / oder Spezialregler (Special controls).

Sie im- / exportieren solch Bediengruppe samt eingestellter Werte, etwa als
Template.

User Level

Per User level regeln Sie Bedienrechte für folgende Rollen:

■ Expert: Projekteigner mit allen Rechten. Darf Projekte, Rechte, Sichtbarkeiten
etc. anlegen und edieren. Kann per Properties für jeden Einzelparameter bis
hin zur kompletten Controls group regeln, wer genau was sehen und edieren
darf.

■ Engineer: Darf Geräteparameter ändern, aber kein Projekt edieren.
■ Mechanic: Ähnelt dem Engineer, erhält aber vom Expert oft weniger

Edierrechte.
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4 Ihr Produkt

Eigenschaften edieren

Einfach ein Element co-klicken, Properties wählen und sichtbaren Namen, Ver-
sionsnummer, Beschreibung hinzufügen: So entsteht individuell Ihr Bedien-
schirm.

Version: 1.0.0 10



5 Installation und Adapter

5 Installation und Adapter

Software installieren, Adapter setzen – schon ist PNDS3 startbereit. PNDS3 Software finden Sie online als
Zip-Download.

1. Website Nanotec > Products > Software > Plug & Drive Studio 3 öffnen.
2. Produkt-Zip-Datei herunterladen und entpacken.
3. Ausführbare Datei PNDS3.exe starten.
4. Nur bei installiertem PNDS3: Bereiten Sie Ihren Feldbus-Adapter vor.

CANopen

1. Entscheiden: Ixxat USB-to-CAN? Oder Nanotec ZK-USB-CAN-1?
2. Für Ixxat USB-to-CAN: Treiber herunterladen (www.ixxat.com/); manuell installieren.
3. Adapter anschließen am PC. Für Nanotec ZK-USB-CAN-1: Selbst-Installation abwarten.
4. Per korrektem Kabel (s. Produkthandbuch): Installierten Adapter anschließen am Controller.

USB: Nanotec Virtual COM-Port (VCP)

1. Spannungsversorgung anschließen am Controller und einschalten.
2. Per korrektem USB-Kabel: PC anschließen am Controller (= "Wechseldatenträger").
3. In Explorer > Controller-Verzeichnis: cfg.txt wählen (= pd4ccfg.txt für einen PD4C).
4. Datei per Texteditor (Notepad etc.) öffnen.
5. Zeilen 2102|=0x100000 und 4015:01=0 einfügen. Datei speichern.
6. Controller neu starten und prüfen, ob sein COM-Port im Gerätemanager erscheint.

Modbus RTU

1. Für Nanotec ZK-USB-RS485-1: Adapter am PC anschließen und Selbst-Installation abwarten.
2. Für andere äquivalente Adapter: Gültige OEM-Anleitung befolgen, um den Treiber zu installieren.

EtherCAT

WinPcap 4.1.3 oder Npcap installieren und sicherstellen, dass der entsprechende Treiber für den
festgelegten Ethernet-Adapter aktiviert ist

Profinet

1. Win10cap oder Npcap installieren und sicherstellen, dass der entsprechende Treiber für den festgelegten
Ethernet-Adapter aktiviert ist

2. IP-Adresse des Antriebs und Ethernet-Adapter entsprechend konfigurieren, wie im Handbuch des
Antriebs beschrieben.

Ethernet (REST)

IP-Adresse des Antriebs und Ethernet-Adapter entsprechend konfigurieren, wie im Handbuch des Antriebs
beschrieben.

Version: 1.0.0 11
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6 Bedienschirm (UI)

6 Bedienschirm (UI)

Dank flexibler Bereiche und Fenster, gefügt ins Hauptfenster oder eigenständig nutzbar, meistern Sie viel-
fältige Aufgaben. Bitte verstehen Sie vor Produktnutzung die UI-Struktur.

Startet PNDS3 zum ersten Mal, wirkt das User Interface eher leer. Aber das ist
gewollt ...

Erstellen oder laden Sie ein Projekt, füllt sich das Interface nach Ihrem Bedarf.
Hierdurch gestalten Sie Ihr eigenes UI.

1 2 3 4

5

678

■ Kopfbalken für Hauptmenü (1), Verbindungsstatus
(2), Kurzstatus (3) und Betriebsbuttons (4)

■ Anzeigewand (5) für Oszilloskop, Objektbuch,
Hilfe etc.

■ Statustafel (6) mit Reitern für Monitore,
Fehlerlisten etc.

■ Werktisch (7) für Bedienregler etc.
■ Projekt- / Seitenleiste (8) für Systeme etc.

6.1 Kopfbalken (1-4)

Als markante Layoutklammer oben im User Interface enthält der UI-Kopf alle bedienrelevanten Grundfunkti-
onen und -befehle.

Version: 1.0.0 12



6 Bedienschirm (UI)

Kopfbalken > Hauptmenü (1)

Ganz links überm Kopfbalken finden Sie das Hauptmenü für Projekte, Geräte,
Tools und Hilfe.

Project: Lädt neue und speichert, öffnet, bearbeitet existente Projekte.

Device: Liest, schreibt, speichert Geräteparameter. Steuert NanoJ-Programme
und Feldbusnetzwerk (bei CANopen).

Help: Öffnet Online-Hilfe und PNDS3-Versionsinfo.

Kopfbalken > Verbindungsstatus (2)

Hier sehen Sie auf einen Blick für das aktuelle System, welches Gerät über
welche Schnittstelle verbunden ist.

Kopfbalken > Kurzstatus (3)

Hier sehen Sie auf einen Blick, ob Config Mode, NanoJ-Programm involviert sind
und welche Fehler vorliegen.

Beispiel: Externer Controller im Konfiguriermodus (= active) mit korrektem Lauf
(= no error) und ohne NanoJ (= off).

Kopfbalken > Betriebsbuttons (4)

Ganz rechts im Kopfbalken makeln diese Buttons Motorstrom, Betriebspara-
meter und Controllerwerte.

Version: 1.0.0 13



6 Bedienschirm (UI)

STOP: Kappt den Motorstrom ohne sicheres Abschalten.

Set: Überträgt die ausgewählten Parameterwerte an systemverbundene Control-
ler.

Anm.: Sie wählen die zu übertagenden Parameter per Haken aus.

Get: Liest die Werte systemverbundener Controller.

Store: Speichert Set-übertragene Werte systemverbundener Controller.

User level: Erteilt Projektrechte für entweder:

■ Expert: Projekteigner mit allen Rechten. Darf Projekte, Rechte, Sichtbarkeiten
etc. anlegen und edieren. Kann per Properties für jeden Einzelparameter bis
hin zur kompletten Controls group regeln, wer genau was sehen und edieren
darf.

■ Engineer: Darf Geräteparameter ändern, nicht Projekte edieren.
■ Mechanic: Ähnelt dem Engineer, oft mit weniger Edierrechten.

6.2 Projektleiste (8)

Diese Seitenleiste zeigt Ihr geladenes Projekt als Baumliste, womit Sie den Bedienschirm erstellen. Anm.:
Je nach Bestückung sind Verbindungen und Attribute aller Baumlisten-Elemente prüfbar im Werktisch (7).

Baumliste

Sie finden die Projektleiste im Bedienbildschirm ganz links.

Ein Projekt (hier: external controller) baumlistet alle Systeme samt der Elemente
darin. Minimum sind ein Projekt und ein System; weitere Elemente sind optional
und prägen später das gesamte UI-Layout.

Unser Beispielprojekt (= blau) enthält das System Axis 1 (= orange).

System Axis 1 enthält die Modulgruppe Controller template samt Einzelmodulen
für communication settings, firmware update, auto-setup, etc.

Version: 1.0.0 14



6 Bedienschirm (UI)

Weitere Module sind etwa Motor, Encoder, Brake und Gear, mit ihren jeweiligen
Modulen für Settings, Bedienreglern und Parametern.

Pro Modul können Sie ein oder mehrere Bedienreglergruppen weiter rechts zum
Werktisch (7) fügen.

Projekt > System

Ein System stellt einen Motor mit Controller dar, bei Mehrachs-Anwendung also
eins pro Motor.

1. Um Systeme anzulegen: Das Projekt co-klicken.
2. Im Kontextmenü: Entweder Neusystem erzeugen per Add new system.
3. Oder Bestandssystem holen per Import system.

4. Ein neuer Knoten (= blau) erscheint in der Baumliste.
5. Zum Benennen: Knoten co-klicken, Properties wählen. Anm.: Jedes Objekt

ist per Co-Klick seiner Properties edierbar.

6. Im Popup: System nach Wahl benennen (hier: Axis 2).
7. Falls nötig: System versionieren und beschreiben.
8. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
9. Erst dann: Popup schließen.
10.System bestücken mit Modulgruppen (s. unten).
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6 Bedienschirm (UI)

Projekt > Module group

Eine Modulgruppe bündelt mehrere Motorfunktionen (= Module). Je nach Be-
stückung sind ihre Verbindungen und Attribute prüfbar im Werktisch (7).

1. Um Modulgruppen anzulegen: Das System co-klicken (hier: Axis 2).
2. Im Kontextmenü: Entweder Neugruppe erzeugen per Add module group.
3. Oder Bestandsgruppe holen per Import module group.

4. Ein neuer Knoten (= blau) erscheint in der Baumliste.
5. Zum Benennen: Knoten co-klicken, Properties wählen. Anm.: Jedes Objekt

ist per Co-Klick seiner Properties edierbar.

6. Im Popup: Modulgruppe nach Wahl benennen (hier: Controller template).
7. Falls nötig: Modulgruppe versionieren und beschreiben.
8. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
9. Erst dann: Popup schließen.
10.Modulgruppe bestücken mit Modulen (s. unten).

Projekt > Module group > Module

Ein Modul erlaubt das Anfügen einzelner Motorfunktionen (= Parametersatz
etc.). Je nach Bestückung sind seine Verbindungen und Attribute prüfbar im
Werktisch (7).

1. Um Module anzulegen: Modulgruppe co-klicken (hier: Controller template).
2. Im Kontextmenü: Entweder Neumodul erzeugen per Add module.
3. Oder Bestandsmodul holen per Import module.

4. Ein neuer Knoten (= blau) erscheint in der Baumliste.
5. Zum Benennen: Knoten co-klicken, Properties wählen. Anm.: Jedes Objekt

ist per Co-Klick seiner Properties edierbar.
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6 Bedienschirm (UI)

6. Im Popup: Modul nach Wahl benennen (hier: Communication settings).
7. Falls nötig: Modul versionieren und beschreiben.
8. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
9. Erst dann: Popup schließen.

10.Falls nötig: Modul per Kontextmenü Add to monitoring panel als Monitor zur
Statustafel (6) fügen.

11.The module appears in the status board's Monitoring tab.
12.Modul bestücken mit Bediengruppen (s. unten).

Projekt > System > Module group > Module > Controls group

Eine Bediengruppe bündelt einzelne Bedienregler oder Parametersätze.

1. Um Bediengruppen anzulegen: Modul co-klicken (hier: Communication set-
tings).

2. Im Kontextmenü: Entweder Neugruppe erzeugen per Add controls group.
3. Oder Bestandsgruppe holen per Import group.

4. In jedem Fall erscheint die Bediengruppe im Werktisch (7).
5. Genau dort: Die Gruppe und ihre Properties co-klicken. Anm.: Jedes Objekt

ist per Co-Klick seiner Properties edierbar.

6. Im Popup: Bediengruppe nach Wahl benennen (hier: CAN configuration).
7. Falls nötig: Gruppe versionieren und beschreiben. Beachte: Pulldowns für

gewährte Sicht- und Edierrechte (hier: beide Mechanic).
8. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
9. Erst dann: Popup schließen.
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6 Bedienschirm (UI)

10.Die Bediengruppe erscheint im Werktisch.
11.Anm.: Zum Löschen einer Bediengruppe ist zuerst jedes Objekt darin zu

löschen.

6.3 Werktisch (7)

Am Werktisch, halblinks im Bedienschirm, bearbeiten Sie Eigenschaften / Inhalte / Bedienelemente Ihres
Projektbaums. Je nach Bestückung sind andere Reiter überm Werktisch:

Ein Attributes-Tab begleitet alle Elemente (auch Modulgruppen); Bus settings
hingegen nur das Projekt selbst. Der Tab Connection settings schließlich ist nur
für Systeme; und Controls nur für Module. Jeder Reiter öffnet andere Aspekte:

Controls groups Bediengruppen

Parameter Bedienwerte

Special controls Spezialregler

Complex controls Komplexe Regler

Ein Werktisch etwa für Motortests enthält etwa die Bediengruppe Testrun, mit
Spezialreglern für Jog mode (1) und Motion test (2).

Plus: Bediengruppe Oscilloscope, mit Spezialreglern für Oscilloscope #1 (3) und
Oscilloscope #2 (4).

Grundprinzip

1. Bediengruppe co-klicken, um deren Kontextmenü zu öffnen.
2. Entweder Add parameter wählen, um die Gruppe zu parametrieren.
3. Oder Add special controls wählen, um eine Complex controls-Liste zu öff-

nen.

4. Im Popup: Per Mausklick / Filter nötiges Element wählen.
5. Zum Bestätigen: Add … / Next klicken (je nach Menü).
6. Falls möglich: Element edieren. Anm: Kein Speichern bei Cancel .
7. Jeden Schritt bestätigen mit Add … / Next (Endschritt: Finish).
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6 Bedienschirm (UI)

8. Das Element erscheint in der Bediengruppe. Dort (falls möglich) parame-
trieren.

Controls group > Parameter (Beispiel: device ID)

Ein Parameter bestimmt und überwacht das Systemverhalten. Je nach Bestü-
ckung sind seine Verbindungen / Attribute prüfbar im Werktisch.

1. Um etwa Device IDs anzulegen: Bediengruppe (hier: CAN configuration) und
Add parameter co-klicken.

2. Im Popup: Device oder 0x4041 eingeben, um das Objekt Device Id zu filtern.

3. Objekt aufklappbar per Maus (oder Haken bei Expand all).
4. Device Id und Next klicken (bei Irrtum: zurück per Back).

5. Im nächsten Popup: Objekt edieren und Finish klicken.
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6 Bedienschirm (UI)

6. Um etwa Baudraten anzulegen: Erneut Bediengruppe (hier: CAN configu-
ration) und Add parameter co-klicken.

7. Im Popup: Etwa nach baudrate or 0x2005 filtern.
8. Etwa CANopen baudrate klicken, dann Next und Finish.

9. Im nächsten Popup: Objekt edieren und Finish klicken.

10.Baudrate erscheint in der Bediengruppe.
11.Falls nötig: Bediengruppe mit Spezialreglern bestücken (s. unten).

Controls group > Special controls (Beispiel: oscilloscope)

Spezialregler bestimmen und überwachen (als Makrosammlung) das System-
verhalten. Je nach Bestückung sind ihre Verbindungen / Attribute prüfbar hier im
Werktisch.

1. Um Spezialregler anzulegen: Bediengruppe co-klicken.

2. Im Kontextmenü: Add special controls wählen.

3. Entscheiden: Complex controls-Tab? Or Device communication settings?
4. Im Reiter der Wahl: Nötiges Element filtern / wählen und Add control.
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6 Bedienschirm (UI)

5. Falls möglich: Manuelle Einstelloptionen prüfen in Preview complex control.
6. Add control klicken.

7. Falls möglich: Element edieren und Finish klicken.

8. Der Spezialregler (hier: Oscilloscope #2) erscheint in der Bediengruppe.
9. Zu Details: Siehe Spezialregler-Setups.

6.4 Anzeigewand (5)

Die Anzeigewand zeigt Oszilloskopdaten, aktuelle OD-Werte und die Hilfe.

Mehrere Reiter erleichtern die Navigation in der Anzeigewand, oben rechts im
Bedienschirm.

Oscilloscope: Siehe Special controls > Oscilloscope console.

OD monitor: Listet alle Objekte aus dem Objektverzeichnis des Controllers mit
ihren aktuellen Werten. Für Updates: Read klicken.

Zum Speichern der Liste als Textdatei auf Festplatte: Dump klicken. Textdatei
mit aktuellen Werten bei Support-Anfragen bereithalten.

Help: Zeigt die Beschreibung des aktuell gewählten Elements (OD-Objekt).

6.5 Statustafel (6)

Hier, rechts unten im Bedienbildschirm, überwachen Sie ihr System per Monitoring, Fehlerlisten, NanoJ etc.
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6 Bedienschirm (UI)

Die Statustafel ist unten rechts im Bedienschirm. Sie hat Register für Monitoring,
Console, Version, Error list und NanoJ control.

Monitoring > Monitor anlegen (Beispiel: Test)

Im Monitoring-Tab kombinieren Sie einzelne wie auch gruppierte Monitore, um
einzelnes Systemverhalten in Echtzeit zu verfolgen.

1. Um Monitore anzulegen: Reiter Monitoring co-klicken.
2. Im Kontextmenü: Entweder Neumonitor erzeugen per Add monitor module.
3. Oder Bestandsmonitor holen per Import module.

4. Neumonitor-Reiter und Properties co-klicken. Anm.: Jedes Objekt ist per
Properties edierbar.

5. Im Popup: Neumonitor nach Wahl benennen (hier: Test).
6. Falls nötig: Monitor versionieren und beschreiben.
7. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
8. Erst dann: Popup schließen.

Monitoring > Gruppe anlegen (Beispiel: Statusword)

1. Monitor der Wahl und Add group co-klicken.

2. New group > Properties co-klicken. Anm.: Jedes Objekt ist per Properties
edierbar.

3. Im Popup: Neugruppe nach Wahl benennen (hier: Statusword).
4. Falls nötig: Gruppe versionieren und beschreiben.
5. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
6. Erst dann: Popup schließen.
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6 Bedienschirm (UI)

Monitoring > Parameter anlegen (Beispiel: Statusword-Objektformat)

1. Gruppe der Wahl und Add > Parameter co-klicken.

2. Per Filtereintrag: Objekt der Wahl finden (hier: 0x6041 Statusword).
3. Falls nötig: Unterobjekt wählen (hier: Statusword).
4. Next klicken.

5. Als (visuelles) Objektformat: Entweder Standard 0x0000 wählen.

■ Oder 1-LED einzeln.
■ Oder Reihe à 8-LED.

6. Finish klicken.
7. Alle Objektformate der Wahl anfügen.

8. Für 16 (oder gar 32) Bits sind mehrere Reihen à 8-LED kombinierbar.
9. Ab Werk zeigt jede LED-Reihe Bit 0 bis 7.
10.Um etwa Bit 24 bis 32 zu zeigen: LED-Reihe und Properties co-klicken.

Anm.: Jedes Objekt ist per Properties edierbar.

11.Im Popup: Bitversatz etwa auf 24 ändern.
12.Tabstopp setzen (damit sich alles speichert).
13.Falls sinnig: Beschreibung anfügen, etwa Statusbits 24 - 31.

14.Bitversatz für jede 8-Bit-Reihe ändern.
15.Nach jeder Eingabe : Tabstopp setzen (damit sich alles speichert).
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7 Projekt-Setup

Nur per Projekt gehen Sie erste Software-Schritte und verwalten Geräte, Einstellungen, Verbindungen etc.
Anm.: Ab Werk liegt im Projects-Ordner der Software je ein Musterprojekt für motor-externe und für NanoJ-
integrierte Controller. Nanotec empfiehlt diese Vorlagen zu nutzen.

Expertenrechte erteilen

1. Stromversorgung und Kabel zum Controller anschließen.
2. Im Bedienschirm: Betriebsbuttons (4) aufsuchen.

3. Per Button: User > Expert wählen.

Projekt laden / anlegen

1. Im Bedienschirm: Hauptmenü aufsuchen.

2. Am besten per Project > Open ein existentes Musterprojekt als Vorlage
wählen.

3. Oder, für ein Neuprojekt: Project > New wählen.

4. Will ein Popup das aktuelle Projekt speichern: Yes klicken.

■ No schließt das Projekt ungespeichert und ohne Backup.
■ Cancel schließt nur das Popup.

5. Die neu geladene Auswahl erscheint in der Projektleiste (8)

Falls nötig: Projekt benennen

1. Projektleiste (8) aufsuchen.

Version: 1.0.0 24



7 Projekt-Setup

2. Aktuelles Projekt und Properties co-klicken.

3. Im Popup: Projekt nach Wahl benennen, versionieren und beschreiben (hier:
Project Ixxat). Beachten: Pulldown für gewährte Nutzrechte (hier: Expert).

4. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
5. Erst dann: Popup schließen.

System laden / anlegen

1. Projektleiste (8) aufsuchen.

1. Im Projekt: Am besten per Import system ein existentes Mustersystem als
Vorlage wählen.

2. Oder, für ein Neusystem: Add new system wählen.

3. Im Popup: System nach Wahl benennen, versionieren, beschreiben (hier: X
Axis, Version V1, für PD4-C).

4. Nach letzter Eingabe: Tabstopp setzen (damit sich alles speichert).
5. Erst dann: Popup schließen.
6. Für jedes weitere System wiederholen.

Mit Adapter verbinden

1. In der Projektleiste (8): Projekt öffnen.
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7 Projekt-Setup

2. Im Werktisch (7): Reiter Bus settings öffnen.

3. Im Bus settings-Reiter: Bus type wählen.
4. Setup prüfen per Scan adapters. Falls negativ: Adapter setzen und erneut

prüfen.
5. Nötigen Adapter wählen.

6. Adapter ver- / entlinkbar per Icon Connect (hier: grün).

Mit System verbinden

1. Werktisch (7) aufsuchen.

1. Bei verlinktem Adapter sehen Sie alle verbundene Geräte.
2. Scan devices klicken. Connected device prüfen.
3. Per Pulldown: System zum Verlinken Ihres Geräts wählen.

4. System verlink- / entlinkbar per Icon Connect (hier: grün).
5. Verlinkt erreichen Sie die Geräteparameter.

OD-File wählen

PNDS3 zeigt Objekte passend zur Controller-Firmware nur mit korrektem OD-File (object dictionary). Ist
das System verlinkt, zeigt ein Reiter Version, ob das richtige OD-File geladen ist. Alternativ lädt sich das
generische File Common OD, womit Sie verfügbare Objekte aller Nanotec-Produkte erreichen.

1. Statustafel (6) aufsuchen.
2. Reiter Version öffnen.

■ Common OD: Neu ladbar per Remove OD file
■ OD-File der Wahl: Ladbar per Change OD file
■ Firmwarekorrekte OD-Files für alle Nanotec-Controller: Im PNDS3-Ordner

Firmware

Falsche OD-Files melden einen Fehler (= rot).
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8 Spezialregler-Setups

Per Special controls ergänzen Sie den Bedienschirm um Complex controls und Device communication
settings. Beides hilft Ihnen erweiterte Controllerfunktionen zu nutzen.

Grundprinzip

Spezialregler bestimmen und überwachen (als Makrosammlung) das
Systemverhalten. Je nach Bestückung sind ihre Verbindungen / Attribute prüfbar
hier im Werktisch.

1. Um komplexe Regler oder Gerätekommunikation anzulegen: Bediengruppe
co-klicken.

2. Add special controls wählen.

3. Complex controls? Device communication settings? Reiter der Wahl öffnen.
4. Nötiges Element wählen und Add ... / Next (je nach Menü).

5. Falls möglich: Manuelle Einstelloptionen prüfen in Preview complex control.
6. Falls möglich: Element edieren. Anm: Kein Speichern bei Cancel.
7. Jeden Schritt bestätigen mit Add ... / Next (bei Irrtum: zurück per Back).
8. Freigeben mit Finish.

→ Regler / Einstellung der Wahl erscheint im Werktisch
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8 Spezialregler-Setups

8.1 Komplexe Regler

VORSICHT

!
Verletzung: durch abrupten Motorlauf nach Auto-Setup (= Parameterverlust)!

► Für Motor mit eingebautem Controller: Auto-Setup verhüten (da schon ab Werk
durchgeführt).

► Andernfalls: Motor nach Auto-Setup neu starten (Homing allein reicht nicht).

► Bewegten Motorteilen fernbleiben.

► Motor nur im Stillstand berühren.

HINWEIS

Motorfehlfunktion: durch Auto-Setup-Bedienfehler!

► Mögliche NanoJ-Programme beenden (Objekt 2300h:00h Bit 0 = "0"; cf. 2300h NanoJ
Control).

► Motor lastfrei halten, und in beliebige Richtung frei drehbar.

► Motor nicht berühren.

Per Makrosammlung Complex controls gestalten Sie eigene Controllerfunktionen. Neben Autosetup und
Firmware update zählen hierzu Jog console, Motion test, NanoJ control und Oscilloscope console etc.

Auto-Setup

Autosetup ist nötig, um Motor und angeschlossene Sensoren (Encoder / Hallsensoren) zu parametrieren.

Solange der Motor am Controller oder die Rückführ-
sensoren (Encoder / Hall) gleichbleiben: Autosetup
nur einmal bei Erstinbetriebnahme durchführen.

Firmware-Update

Nanotec empfiehlt die Controller-Firmware FIR-v2139 oder neuer. Die aktuelle Version liegt im Ordner Firm-
ware. Sie starten Firmware update im Werktisch (7):

1. In Bediengruppe der Wahl: Reiter Controls öffnen
und Firmware update suchen.

2. Dort: Load from file klicken.
3. Firmware-Datei wählen und Öffnen klicken.
4. PNDS3 prüft per Produktcode, ob gewählte Datei

zum Produkt passt.
5. Update device klicken.
6. Firmware aktualisiert sich.

Anm.: Die gewählte Firmware-Datei speichert sich
beim nächsten Speichern des Projekts als dessen
Teil. Soll das unterbleiben, klicken Sie zuvor Remove
from project.
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8 Spezialregler-Setups

Jog-Pult

Per Jog console testen Sie den Motor im Drehzahl-
modus. Wählbar sind zwei Zielgeschwindigkeiten.
Der Motor fährt, solange Sie per Maus den Button für
je Links- / Rechtslauf drücken.

Bewegungstest

In Motion test prüfen Sie den Motor im Positions- /
Drehzahl- / Drehmomentmodus. Ihre Optionen um-
fassen Sollwerte, Beschleunigungs- / Verzögerungs-
rampen, Wiederholzyklen, Testlaufdauer etc.

NanoJ-Pult > Controls

In NanoJ control > Controls erstellen Sie ein NanoJ-
Neuprojekt (= New), benennen / versionieren es per
Handeintrag und speichern es per Save. Button Build
kompiliert das Projekt.

Per Import importieren Sie existente NanoJ-Projekte
der Wahl.

Sie können das gesamte Modul exportieren. Haben
Sie Publish gedrückt, wird das Projekt ohne den
Quellcode exportiert.

Anm.: Bei nächstem Speichern des Projekts geht
die gewählte NanoJ-Datei ins Projekt über. Soll das
unterbleiben, klicken Sie zuvor Remove. Das aktive
NanoJ-Programm auf dem Controller verändern Sie
per Program und steuern es per Run oder Stop.

Oszilloskop-Pult

Per Oscilloscope verfolgen und regeln Sie in Echtzeit
den aktuellen Wert von Geräte-Parametern aus dem
Objektverzeichnis, etwa zum Aufzeichnen.

■ Dauer der Aufzeichnung
■ Anzahl der Oszilloskop-Fenster

Sie co-klicken die Datentabelle im Pult und wählen
Add oscilloscope data entry. Aus der Liste klicken
Sie einen Eintragstyp und Select. Sie wiederholen
den Vorgang für jeden Eintragstyp der Wahl.

Zum Aufzeichnen öffnen Sie in der Anzeigewand (5)
den Reiter Oscilloscope.
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8 Spezialregler-Setups

Start klicken und eine Option wählen:

■ Auto Start: Aufzeichnung beginnt, sobald ein
Parameter der Wahl seinen Wert ändert. Sie
starten etwa einen Motion test und prüfen die
Drehzahl- / Positionskurve im Oszilloskop.

■ Continuous Mode: Aufzeichnung beginnt, sobald
Sie Start klicken.

Memo Text

Fügt eine frei editierbare Textbox hinzu.

8.2 Gerätekommunikation

Mit diesen Reglern parametrieren Sie die Gerätekommunikation. Anm.: Codierschalter zum Setzen der
Kommunikationsparameter überschreiben je nach Gerät die Software-Einstellung. Zu Details: Gültige OEM-
Anleitungen befolgen.
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